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Flash 
Fundamentals

The Flash authoring
program is the perfect tool
for both new and
experienced Web page
designers who want to
create expressive, dynamic
Web page elements. In this
chapter, you learn all the
basics for starting Flash
files and finding your way
around the program
window. 
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Adobe Flash is the program of
choice for multimedia authoring
projects. You can use Flash to
create animations, Web page
components, games, applications,
and mobile phone content. Using
the Flash Player plug-in, just
about every Web browser available
today supports Flash-based
content. In the strictest sense,
Flash is an integrated development
environment, while the Flash
Player is a virtual machine for
running Flash files. 

Animations
Web page components
Games
Applications

Mobile phone c
ontent

Introduction 
to Flash

4

Create Animation Content
Flash includes a variety of tools you can use to draw
your own graphic objects to use in your projects.
Flash-created vector graphics are much smaller in
file size than raster graphics, such as JPEGs and
GIFs. Vector graphics display much faster on a
downloading Web page and are a more efficient
method of delivering images over the Internet. To
learn more about creating objects, see Chapters 2
and 3. To learn how to import artwork, see Chapter
4. See Chapter 5 to learn about adding text.

Flash

JPEG

Work with Symbols
After creating new objects or importing artwork from
other sources, you can turn objects into symbols to
reuse in your Flash movie. Every time you use a
symbol, you use an instance of the original object. If
you make changes to the original, the instance
changes as well. Flash keeps track of your symbols in
the file’s Library. To learn more about using symbols
and instances, see Chapter 7.
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5

Build Animation Sequences
You can use the Flash animation tools to create all
kinds of animation effects, from making an object
move across the screen to complex animations that
follow paths and action commands. You can create
animations using frames. A frame stores content, and
the total number of frames determines the length of
your movie. For more on creating animations, see
Chapters 8 and 9. To learn how to add sound to your
animations, see Chapter 13.

“Air Fig
hters”

Act 2
Scene 7

12-07-07

Take 1

Organize with Layers
You can use layers in your Flash movies to organize
content and add depth to your animations. Each layer
acts like a transparent sheet, allowing you to view
underlying layers. You can manage layers in the Flash
Timeline window. To learn more about working with
layers and the Flash Timeline, see Chapter 6

BackgroundBackground

Layer 1
Layer 2Layer 2

Layer 3Layer 3

Add Interactive Elements
You can also use the Flash tools to create interactive
elements in your movie and assign actions. For
example, you can add a button that, when clicked,
activates another movie. A programming language
called ActionScript controls interactivity in Flash. You
do not need to know how to write ActionScript to
add interactivity; Flash includes numerous prewritten
scripts that you can apply. To learn more about adding
buttons, see Chapter 11. To learn about adding
actions, see Chapter 12.

Click here to see the fighter plane in action!
START

Publish Your Movies
There are a variety of ways you can share your
animations with others. Flash includes options for
publishing movies to Web pages, as Flash movie files,
or as self-extracting animations. The program also
includes features to help you preview a movie before
publishing, test download performance, and more. To
learn more about publishing your Flash projects, see
Chapter 15.

Click here to see the fighter plane in action!

Flash Fundamentals chapter1
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The Flash program window has several components for working with graphics
and movies. Take time to familiarize yourself with the on-screen elements. 
If you use Flash on a Macintosh computer, the program elements may look 
a bit different than those displayed in the following Windows example.

TITLE BAR
Displays the name of the open file.

MENU BAR
Displays Flash menus which, when
clicked, reveal commands.

FILE TAB
The tab at the top of the work
area represents the current file. If
two or more files are open, you
can switch from file to file by
clicking a tab.

TIMELINE
Contains all the frames, layers,
and scenes that make up a movie.

TOOLS PANEL
Contains the basic tools needed to
create and work with vector graphics.

CURRENT SCENE
Displays the name of the scene on
which you are currently working.

STAGE OR MOVIE AREA
The area where a movie or
graphic displays, where you can
view a frame’s contents and draw
graphic objects. This area is also
called the Flash Editor. 

WORK AREA
The area surrounding the Stage.
Anything placed on the work area
does not appear in the movie.

PROPERTY INSPECTOR
Use this panel to view and edit
properties of the current object.

PANELS
Allow quick access to options for
controlling and editing Flash
movies.

6

Navigate the 
Flash Window

04_171233 ch01.qxp  8/20/07  3:26 PM  Page 6



7

The Flash Timeline contains the frames, layers, and scenes that make up a movie.
You can use the Timeline to organize and control your movies. By default, the
Timeline appears docked near the top of the program window. If you are new to
Flash, take a moment and familiarize yourself with the Timeline elements.
See Chapters 8, 9, and 10 for more on working with the Flash Timeline.

LAYERS
Use layers to organize artwork,
animation, sound, and interactive
elements. Layers enable you to
keep pieces of artwork separate and
combine them to form a cohesive
image, such as a company logo that
includes a layer of text and another
layer with a graphic shape.

FRAMES
Lengths of time in a Flash movie
are divided into frames. They
enable you to control what
appears in animation sequences
and which sounds play.

FRAME NUMBERS
Frames appear in chronological
order in the Timeline, and each
frame has a number.

PLAYHEAD
Also called the Current Frame
Indicator, the playhead marks the
current frame displayed on the
Stage. 

PANEL MENU
Displays a drop-down menu of
customizing options for controlling
how frames are displayed in the
Timeline.

TIMELINE BUTTONS
Scattered around the Timeline are
buttons for controlling frames,
layers, and movies. 

LAYER BUTTONS
Click to add and delete layers. 

LAYER CONTROLS
Display the status of a layer, such
as hidden, locked, or outlined. 

Understanding the 
Flash Timeline Flash Fundamentals chapter1
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Flash files are called documents
or movies. When you save a file,
you can open it and work on it
again. You can make Flash files
as simple as a drawing you create
using the Flash drawing tools, or
as complex as an animation
sequence consisting of scenes
and interactive elements.

OPEN A FLASH FILE

1 Click File.

2 Click Open.

If the Main toolbar is displayed, you can click the
Open button ( ) to display the Open dialog box.

You can also press + ( + ) to open the
Open dialog box.

l You can open a recent file by clicking here and
clicking the file name.

Note: When you first open Flash, you can use the Welcome screen to
open existing files or create new files. Click Open to display the Open
dialog box.

The Open dialog box appears.

3 Click to navigate to the folder or drive
containing the file you want to open.

4 Click the file name.

l You can change the file types listed by clicking
here and choosing a file type.

5 Click Open.

The file opens in the Flash window.

11

33

44

22

55

Air F
igh

ter
s

You can also start a new Flash file at any time,
even if you are currently working on another file.
Every new file you start uses a default Stage size.
If the file windows are maximized, each open file
appears as a tab at the top of the Timeline. 

Open a Flash File

Open a 
Flash File

8
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Why does Flash not show a Main toolbar by
default?
The Main toolbar includes access to common
commands, such as Open and
Save. For example, to open a
file, click the Open button
( ). By default, Flash
does not display the Main
toolbar, but you can turn it
on if you want. Click
Windows, Toolbars, and
then Main.

Toolbar ON

OFF

Is there a limit to how many
Flash files I can have open?
No. However, the more files you
open, the slower your computer
runs. Graphics files, such as those
that you author in Flash, can take
up more processing power than
other programs. Unless you are
sharing data between the files, it
is a good idea to close Flash files
you are no longer using.

OPEN A NEW FLASH FILE

1 Click File.

2 Click New.

If the Main toolbar is displayed, you can
click the New button ( ) to display the
New Document dialog box.

You can also press + ( + ) to
open the New Document dialog box.

Note: When you first open Flash, you can use the Welcome
screen to open existing files or create new files. From the
Create New column, click the type of file you want to create.

11

33

44

22

9

The New Document dialog box appears.

3 Click the type of document you want to
create.

l A description of each type appears here.

4 Click OK.

A blank document appears in the Flash
window.

You can have several Flash files open and
switch between them using the tabs at the
top of the Timeline.

Note: You can also use the Window menu to switch between
open files.

Flash Fundamentals chapter1
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As you create movies in Flash, you
need to save them to work on them
again. By default, Flash saves all files
in the FLA format. Because Flash
does not offer an automatic save
feature, it is a good practice to save
your work frequently.

SAVE A FILE

1 Click File.

2 Click Save.

If the Main toolbar is displayed, you
can click the Save button ( ) to
display the Save As dialog box.

You can also press + ( + )
to open the Save As dialog box.

11

22

33 44

Recipes

Air Fighters

A
You can close Flash files no longer in use to free
up computer memory. Be sure to save your
changes before closing a file.

Saving graphics to the Flash Library works a bit
differently than saving a file. See Chapter 7 for
more information about saving symbols.

Save and Close a Flash File

Save and Close 
a Flash File

10

The Save As dialog box appears.

Note: If you have previously saved a file, Flash saves
the changes without displaying the Save As dialog box. 

3 Type a unique name for the file.

l To save to another folder or drive, click
and select another location.

l To save the file as another file type,
click and click a file type.

4 Click Save.

Flash saves your file.
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CLOSE A FLASH FILE

1 Save your file.

Note: See the previous steps to learn how to save a Flash file.

2 Click File.

3 Click Close.

Flash closes the file you are working on,
but the program window remains open.

Note: If you have not saved your changes, Flash prompts you
to do so before closing a file.

22

33

22

11

How do I save a previously saved file under
a new name?
You can copy a previously saved
file and save it under a new
file name. You can then
make changes to the
file copy without
worrying about
changing the original
file. To do so, click File,
then click Save As. In
the Save As dialog box
that appears, type a new
name for the file and click Save.

Fast Cars
The

Winner’s
Circle

Can I save a Flash file in another format?
Yes; however, you cannot
use the Save command
unless you want to save
the file in an older Flash
program version. Instead,
you must export the
movie to another file
format. See Chapter 13
to learn how.

Fast Cars

USE THE CLOSE BUTTON

1 Save your file.

2 Click the Close button ( ).

Note: Clicking the program window’s button closes the
Flash application entirely and might result in lost data.

Note: If you have not saved your changes, Flash prompts you
to do so before closing a file.

Flash Fundamentals chapter1
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The document you create in Flash
appears on the Stage, which is the
on-screen area where you can view
the contents of a frame and draw
graphic objects. You can control
the size and appearance of the
document you create on the Stage.
The size of the document
determines the size of your Flash
movie screen.

1 Click Modify.

2 Click Document.

You can also click on the Size button in
the Property inspector to display the
Document Properties dialog box.

11
22

33

It is a good idea to set your movie size before
adding any content to your frames. If you set a
size after creating your movie, you may end up
needing to reposition objects to fit the new size.

Change the Document Size

Change the 
Document Size

12

The Document Properties dialog box
appears.

3 To change the stage’s dimensions in
pixels, type new dimensions in the
width and height boxes.

Note: You can also use the Document Properties dialog
box to set a frame rate for your movie. See Chapter 8 to
learn more about frame rates.
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l You can select Printer ( changes to ) if
you want to match the Stage dimensions to
the maximum available print area size for
your printer.

l You can select Contents ( changes to )
to change the Stage dimensions to match the
contents of your movie, with equal spacing
all around.

l You can select Default ( changes to )
to return the Stage size to the default size.

4 Click OK.

l Flash resizes the Stage area according to
your new settings.

44

13

How do I specify different units of
measurement for the Stage?
From the Document
Properties dialog box, click
the Ruler units and
then click the unit of
measurement you want
to apply. The unit of
measurement
immediately changes in
the width and height text
boxes and you can now set
the appropriate measurements.

RulerUnits
Pixels

InchesPointsCentimetersMillimeters

How do I set a new background color?
By default, Flash sets the Stage background
color to white. To set another background
color, click the Background
Color button ( ) in the
Document Properties
dialog box. A palette of
color choices appears.
Click the color you
want to apply and the
color becomes the new
background color
throughout your movie.

Flash Fundamentals chapter1
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You can use the Property inspector
to see and edit the properties of the
object with which you are currently
working. The Property inspector
changes to reflect the properties
associated with the object you select
on the Stage. By default, the
Property inspector appears open
when you first open a Flash file. 

COLLAPSE AND EXPAND THE
PROPERTY INSPECTOR

1 Click the panel’s title bar or name to
collapse or minimize the panel. 

l You can also click the Minimize
button ( ) to collapse the panel 
( becomes ).

Note: This example shows the text properties listed in the
Property inspector panel. 11

22

Properties
Size:

Publish:

Background:

Player:

400 x 200 px

Settings

9

Filters
Parameters

Component

Drop Shadow

Blur
Glow
Bevel

W:
H:

X:
Y:

<Instance Name>

The Property inspector acts as a panel that you can
collapse, hide from view, or move. By default, Flash
docks the Property inspector at the bottom of the
program window. You can collapse or close the Property
inspector when you do not need it to free up workspace.

Using the Property Inspector

Using the Property 
Inspector

14

l The Property inspector panel collapses.

2 To expand the panel again, click the
panel’s title bar. 

l You can also click the Maximize
button ( ).
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CLOSE THE PANEL

1 To close the panel, click the Close
button ( ).

Flash closes the Property inspector.

44

22

33

11

15

What do the other tabs in the Property
inspector do?
In addition to the Properties tab and depending
on what version of Flash CS3 you are using, the
Property inspector panel displays two other tabs:
Parameters and Filters. The
Parameters tab displays
information about
components. See Chapter
12 to learn how to use
components in Flash. If
you are using Flash CS3
Professional, the Filters tab
appears. You can use the
Filters tab to apply filters to
your movie objects. To learn more
about filters, see Chapter 10.

Filters
Parameters

Can I move the Property inspector panel?
Yes. Like all panels in
Flash, you can move the
Property inspector to
create a floating panel
or you can dock the
panel on another side of
the screen. To move the
panel, click and drag the
drag area, the upper-left
corner of the panel. To
collapse a floating panel,
simply click the panel’s title bar. To
expand it again, click the bar again.

Properties Filters
ParametersFl

OPEN THE PANEL

2 To display the panel, click Window.

3 Click Properties.

4 Click Properties.

You can also press + ( + ) to
quickly open the panel.

Flash opens the Property inspector.

Flash Fundamentals chapter1
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You can use the Flash panels to access
additional controls. Flash offers over a
dozen different panels, each displaying
options related to a specific task. Panels
can appear docked to the side of the
program window or they can appear as
floating panels. When you no longer
need them, you can close panels to free
up on-screen workspace. 

OPEN PANELS

1 Click Window.

2 Click the panel you want to open.

Note: A check mark next to the panel name indicates the
panel is open; no check mark means the panel is closed.

l The panel appears on-screen.

11

11

22

Air FightersAir Fighters

Lib
rar

y

Lib
rar

yColor

Swatches

Movie Explorer

To
ols

You can open a default set of commonly used panels in
Flash that include the Color, Swatches, and Library
panels. Flash considers the Property inspector, Library,
Actions, and Movie Explorer panels as main authoring
panels. You can find all the Flash panels listed on the
Window menu.

Work With Panels

Work with 
Panels

16

COLLAPSE AND EXPAND PANELS

1 Click the panel’s title bar or name to
collapse or minimize the panel. 

l You can also click the Minimize
button ( ) to collapse the panel (
becomes ) and click the Maximize
button ( ) to expand the panel again.
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MOVE A PANEL

1 Click and drag the panel’s title bar to
undock and move a panel.

When you undock a docked panel, it
becomes a floating panel that you can
move freely about the program window.

To resize a panel, move the over the
border of a panel ( changes to ), then
click and drag to resize the panel.

11

11

17

Can I hide all the panels at once?
Yes. Click the Window menu and click Hide
Panels or simply press . Flash closes all the
panels, including the Tools panel of drawing tools.
Only the Timeline and the Stage area are left 
on-screen. This frees up
workspace to see the
Stage and any
animations you want to
view. You can use the
Window menu to
reopen any individual
panels you want to view
and use again, or you
can press again to
toggle the panel display
back again.

HIDEHIDEHIDEHIDEHIDE

Can I create a custom workspace with only
the panels I want to use?
Yes. To create a custom workspace, open all the
panels you want to save as your custom
workspace and arrange them how you want them
to appear in the program window. Next, click the
Window menu and click
Workspace, Save Current.
The Save Workspace Layout
dialog box appears. Type a
name for the layout and
click OK. Flash saves the
layout. To restore it at any
time, click Window,
Workspace, and the name
of the layout, or click the
Workspace button at the top of
the Stage and click a layout.

TitleTitle

SA
VE

CLOSE PANELS

1 Click the panel’s Close button ( ).

The panel closes.

l To hide a panel instead of close it, click
the panel’s title bar.

Flash Fundamentals chapter1
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When working with various
elements on the Stage, you can
zoom in or out for a better view.
For example, you may need to
zoom in to see the details of an
object you are editing, or you
might need to zoom out to see
the entire Stage area.

ZOOM OUT

1 Click View.

2 Click Zoom Out.

l Flash zooms your view of the Stage.

You can select the command again to
zoom out another magnification level.

11
22

11
22

Zooming your view merely changes the
magnification of the Stage area and
does not change the size of the objects
you are viewing.

Zoom Out or In

Zoom 
Out or In

18

ZOOM IN

1 Click View.

2 Click Zoom In.

l Flash zooms your view of the Stage.

You can select the command again to
zoom in another magnification level.
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SELECT A ZOOM PERCENTAGE

1 Click .

2 Click a magnification percentage.

11

22

19

How do I use the Zoom tool button?
You can also use the Zoom button on the Tools
panel to change the Stage magnification. Click the
Zoom button ( ) and click
either the Enlarge
modifier ( ) or the
Reduce modifier ( ) at
the bottom of the Tools
panel. Next, click the
area of the Stage you
want to view. Flash
immediately enlarges or
reduces the view.

Is there a quicker way to zoom in Flash?
You can temporarily zoom from Enlarge to Reduce
and vice versa by pressing
and holding the key
( ) as long as the
Zoom tool is active on
the Tools panel. You can
also temporarily zoom
your view while using
another tool on the Tools
panel simply by pressing

+ +
( ). You can also press +1 ( + )
to zoom to 100%, or press + and +
to zoom out and in.

Flash immediately adjusts the view.

l In this example, the window zooms to
50%.

Flash Fundamentals chapter1
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To help you draw with more
precision, turn on the Flash
Rulers and grid lines. Both tools
can help you position objects on
the Stage. The rulers and grids
do not appear in the final movie.

ACTIVATE THE FLASH RULERS

1 Click View.

2 Click Rulers.

11

22

You can use rulers to measure the
various elements on the Stage. You can
use gridlines to help you quickly
position elements on the Stage.

Using Rulers and Grids

Using Rulers 
and Grids

20

l Flash opens horizontal and vertical
rulers in the Stage area.

You can repeat steps 1 and 2 to turn
off the rulers.

04_171233 ch01.qxp  8/20/07  3:26 PM  Page 20



TURN ON GRID LINES

1 Click View.

2 Click Grid.

3 Click Show Grid.

11

22 33

21

How can I precisely align
objects with the grid?
Use the Snap tool to help you
quickly align objects to the
grid lines. To activate the
tool, click View, click
Snapping, and click a
snapping command. You
can also click View,
Snapping, and then click
Snap To Grid.

snap!
snap!
snap!

What are guides?
Guides are lines you can drag
onto the Stage to help you
as you move items and
control positioning. You
can turn on the Flash
guides as another tool
to help you position
objects on the Stage. To
display the guides, click
the View menu and then
click Guides, Show Guides. You
must also turn on the Flash rulers in
order to use guides. To add a guide to
the Stage, drag a guideline off of the
ruler and onto the Stage. To remove a
guide, drag it back to the ruler.

l Grid lines appear on the Stage.

You can repeat steps 1 to 3 to turn off the
grid lines.

Flash Fundamentals chapter1

04_171233 ch01.qxp  8/20/07  3:26 PM  Page 21



When you run across a program 
feature or technique that you do not
understand, consult the Flash Help
system. The Flash Help files offer a
wide variety of topics ranging from
basic Flash features, such as how to use
on-screen buttons and drawing tools,
to advanced features, such as how to
write scripts using ActionScript.

OPEN THE HELP PANEL

1 Click Help.

2 Click Flash Help.

11

33

22

44

Flash

Help

You display the Flash Help information in the
Help panel. Like the other panels available in
Flash, you can move, resize, collapse, and
expand the Help panel. See the section “Work
with Panels” to learn more.

Find Help with Flash

Find Help 
with Flash

22

l The Help panel opens.

3 Double-click a topic category you want
to know more about.

l You can click a subtopic to reveal a list
of Help topics to choose from.

4 Click a topic.
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l The Help information appears and you
can read more about the topic.

l You can click the navigation buttons,
History Back ( ) and History
Forward ( ) to move back and forth
between topics.

Some topics include additional links in the
help text you can click to view more
information or related topics.

l You can look up a topic by typing a
keyword or phrase here and pressing

( ) or clicking the Search
button.

l Click here to return to the main list of
Help topics.

CLOSE THE HELP PANEL

5 Click the Close button ( ).

Flash closes the Help panel.

55

23

Where else can I find Flash help?
Adobe’s Web site (www.adobe.com/
support/flash/) is a good place to
start if you are looking for
additional information about the
Flash program. To access the site
from Flash, click the Help menu
and select Help Resources Online
or Flash Support Center. This opens
your default Web browser. You may
need to log on to your Internet
connection first. You can also find
numerous sites on the Internet
dedicated to Flash users by performing
a simple search for the keyword Flash
using your favorite search engine. 

Menu
Help ResourcesFlash Support Center

Is there an easy way to find out
what new features appear in
Flash CS3?
You can open the Help
panel directly to a link
to learn about new
program features. To do
so, click Help, What’s
New in Flash CS3. The
Help panel opens to the
information and you can
read all about the new
program features and
improvements. 

FFllaasshh  Neewws

Fllaasshh NNeewwss

Breaking News!
Features!

Flash Fundamentals chapter1
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Flash includes a variety of
templates you can use to create
new Flash files. Templates are a
great way to build a document
and create specialized content.
After you open a template, you
can add content to the file and
save it to reuse again.

1 Click File.

2 Click New.
22

33

11

44

Mobile Devices

Slid
e Shows

Slid
e Shows

Ad P
resenta

tio
ns

Flash installs with a variety of templates
you can use to create content for mobile
devices, slide shows, advertising
presentations, quizzes, and more.

Open a Flash Template

Open a 
Flash Template 

24

The New Document dialog box appears.

3 Click the Templates tab.

l New from Template appears as the dialog
box title.

4 Click a category.

l A list of related templates appears.

l Click a template and view a preview here.

Note: Not all templates include a preview. 

l A description of the template appears here.
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5 Click the template for the type of
document that you want to create.

6 Click OK. 55

66

25

Can I make my own templates in Flash?
Yes. To turn any Flash file into a template file, click
File, Save As Template to open the Save As
Template dialog box. Type a unique name for the
template, select a category to save the template to,
and type a brief description. Click Save and Flash
saves the file and adds it to the templates list. 

How do I save a file I create
with a template?
After you finish working
on the template, you
can save it as a regular
Flash file. Click File,
Save, and assign a
unique name for the
file in the Save As dialog
box. To learn more about
saving files, see the section
“Save and Close a Flash File”
earlier in this chapter. 

l A blank template appears in the Flash
window.

You can add content to create the new file.

Flash Fundamentals chapter1
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